Intermediate Dreamweaver

Macromedia Dreamweaver is a sophisticated graphical HTML editor for the creation of professional-quality Web
pages. Dreamweaver can be used to author a single Web page or to create and manage a multi-page site. The
software allows the user to modify his or her work using a graphical WYSIWYG (What You See Is What You Get)
interface while simultaneously viewing and editing the HTML source code.

In the first workshop/handout, you created a single Web page that contained text, images, tables, and links. This
workshop and handout cover more advanced features of Dreamweaver 3.
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Image Maps

When an image in a Web page is linked, clicking on any part of the image takes the user to just one URL. Image
maps are images that contain links to more than one URL. Hotspots are created on different areas of the image,
each one with a link to a different page or site. Image maps are often used to navigate throughout a Web site.

1. Insert an image in the Web page using the Insert Image icon. Image maps can be created on any
Web image (GIF or JPG) regardless of size. Participants in the Web 250 workshop should insert
the image files saved from the Sample Files Web page.

2. Click on the image to select it. The image map tools are located in the lower right corner of | pasp
the Properties inspector. Type a name for the map in the Properties inspector. DW 2 users: ZIT jim([@ k]
click on the Map button in the Properties inspector to access image map tools e =

3. Create a rectangular or oval hotspot:
o With the image selected, choose the Rectangular Hotspot tool.

e Click and drag to draw a hotspot on the image. Hold down the Shift key while dragging to create a
perfect square.

e If necessary, edit the hotspot with the Pointer Hotspot tool. M
The shape and size of the selection box can be changed by dragging the handles on the corners. Click in
the center of the selection and drag to move the entire hotspot. Use the Delete key on the keyboard to
delete a selected hotspot.

e The Properties inspector changes to display hotspot options:

Link URL Target (If you are

using frames)

Image map help
J Hotspot Link |# @
Targer I ;I Alr
i = Alt text
ap |Map

Y ok .

G

e Type the URL for the link in the Link box in the Properties inspector, including the http:// portion of the
address. Delete the “#” symbol from the Link box before typing the address.

e Type Alt text in the Alt box of the Properties inspector (this text will “pop up” when the user holds his or
her cursor over the hotspot without clicking, and is very important for text-only browsers).

e Choose the Oval Hotspot tool and follow the steps above to create circular and oval hotspots. Preview
your image map by selecting File>Preview in Browser from the menu or pressing the F12 key.

4. To create an irregularly-shaped hotspot:
 Select the Polygon Hotspot tool from the Properties inspector. |5

e Click on the image to define the first corner point. Move the mouse and click again to define the second
point. Continue clicking and releasing around the edge of the hotspot until the desired shape is achieved.

e To move a corner point, use the Pointer Hotspot tool in the Properties inspector. Click inside the
polygon and drag to move the entire hotspot.

e Type the URL and Alt text in the appropriate boxes.
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Rollover Images

A rollover is an image that changes when the cursor moves across it. A rollover actually consists of two images:
the primary image (the image displayed when the page first loads) and the rollover image (the image that appears
when the pointer moves over the primary image). When you create a rollover, both images must be the same
size; if the images are not the same size, Dreamweaver stretches or squeezes the second image to match the
dimensions of the first image.

1. Place the cursor in the Document window where you would like the rollover image to appear.

2. Click the Insert Rollover Image icon in the Objects palette. ,.—‘-J"f
The Insert Rollover Image dialog box opens.

Inzert Rollover Image

R
Image Mame: |Imagel
Cancel |
Original Image: | Browse. .. | e
elp |
Rollaver Image: | Browse...l
V' Preload Rallover Image
When Clicked, Go To URL: | Browse. . |

3. Type a one-word name for the image, if desired, or accept the default name (Image1, Image2, etc.).

4. Type the filename of the Original (primary) Image, or click Browse to locate the file on disk. This is the
image that will appear in the Web page when it loads.

5. Browse to locate the Rollover Image file. This is the image that will appear when the mouse rolls over it the
Original Image.

6. Make sure Preload Rollover Image is checked. This will download both images into memory on the user’s
computer, preventing any delay when the images swap.

7. If the image is a link to another Web page, type the link URL in the Go to URL box.
8. Click OK.

9. If you would like to see the behaviors that have been applied to the image object, click on the |}
Behaviors icon in the status bar of the Document window.

O

[= Histary | [/E] Frames |E§I Layers | 3 Eehaviars | @ﬂ

@B 'E-.-ents For:IfS.U and Later Browser: - I [3[3

Events | Actionz |
[onfouseCut) Swap Image Restore

The Behaviors inspector contains the Events (MouseOver, [anhouseliver] Swap Image
MouseOut) that trigger the rollover Actions (Swap Image, Swap
Image Restore). These are important elements of the JavaScript
code that was generated by Dreamweaver. To modify the rollover
behavior, change the Events and Actions in the Behaviors inspector
(see number 6 on page 4 for details).

The Behaviors inspector opens in a separate window.

10. Save your work. Preview the rollover image by selecting File>Preview in Browser from the menu or
pressing the F12 key.
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Advanced Rollover Behaviors

The Insert Rollover Image icon creates the most basic type of JavaScript rollover: one that swaps the image
beneath the mouse pointer with another image of the same size. More sophisticated JavaScript behaviors can be
created using the Behaviors inspector. When a page contains more than one image, rolling over one image can

change two or more of the images in the page.

Example:
Mousing over one of the words does not swap the image beneath Red
the cursor, but it changes two other images on the page: » Oragge
Yellow
1. The colored square to the right is swapped. Green
2. A plain white square is swapped with the triangular bullet, Blue
causing the bullet to appear to the left of the currently Purple
selected color name.
Steps:

1.

Insert original images. Images must be inserted in the page before rollover behaviors can be

applied to them. Use the Insert Image icon to place all images in the page.

2. Name the original images. Every object to which JavaScript behaviors will be applied must have a name.
To name the images in the page, click on an image to select it, then type a one word name in the name

box in the Properties inspector.

0

alt

=l

Image, 1K R ESrc [imagesfredl.gif
Type image name here ed | Hlzs Lk
Map . ¥ Space Target ;I

Border

3] Align IBrowser Diefault = I %

Names can consist of numbers and letters, and should contain no spaces or punctuation. Every image in

the page must have a unique name.

Document window, or select Window>Behaviors from the menu.

4. Add the Swap Image behavior to an image.

e Click on an image to select it — this is the image to which
the behavior will be applied. Rather than selecting the
image that will be swapped, select the one that will be rolled
over by the user to trigger the other image to swap.

In the example at the top of the page, the image with the
word “orange” is selected instead of the colored square to
the right or the bullet image to the left.

Click on the plus sign in the upper left corner of the
Behaviors inspector to reveal a pull-down menu of all
available behaviors.

Select the Swap Image behavior from the list. The Swap
Image dialog box appears.

Filename: intermed_dw.doc
Last Updated: 11/20/2000 athwaits

Copyright Arizona

Open the Behaviors inspector by clicking on the Behaviors icon in the status bar of the

[ Histary | iE] Frames H—_‘;l Layers | 54 Behaviors | @ ﬂ

E]B Ewvents For:l 3.0 and Later Browser: = I BB

Call JavaSeript
Chahge Property
Check. Browser

Check Plugin

Eontral Shockwaye o Elash
[rag Layes

Go To URL

Jurp M ERu

Jump HMenu Go

Open Brovser Window
Play Sound

Popup Meszage
Preload Images

Set Maw Bar Image

Set Text

Shaw-Hide Layers

Swap Image Restore [ g

3

]

Timeline

Board of Regents, 2000.

The University of Arizona Library

—




5. The Swap Image dialog box.

o Alist of all of the images in the page is listed in the top half of the Swap Image dialog box. The image
that was selected when the Swap Image behavior was added is selected in the list.

Swap Image

Select the image

Images:

to be swapped

This box contains
filename of
rollover image

Set Source to:

image "bullet1" il
imange "red'’

image "'white2
image "bullet2" LI

limages/red2.git Browse. . I

V¥ Freload Images

V¥ Festors Images ont auselut

Cancel

Pl

Help

Click to browse
for the rollover
image on disk

e Choose the rollover image by typing an image filename in the Set Source to box, or click the Browse
button to search for the image.

e Make sure the Preload Images and Restore Images onMouseOut boxes are checked. Do not click

OK yet.

o |f the rollover should swap more than one image, select a second image from the list of images.
Browse for the corresponding rollover image.

Rollover images can be selected for every image in the page, if desired. Click on each image in the
list to set the source for the swapped image. Asterisks appear in the list to the right of images for
which rollover images have been selected.

e Now you can click OK.

6. Modifying Rollovers:

o To modify an existing rollover, open the Behaviors inspector and click on the image to which the
behavior was applied. The Events and Actions applied to that image are listed in the inspector

window.

| @]
@B Events For: I 3.0 and Later Browser: _I BB
Events | Actions

[onbAouseCiur) Swap Image Restore
[onflouseCver) Swap Image

Double-click to reopen
the Swap Image dialog
box and modify rollovers.

e Locate the words “Swap Image” in the list of actions. Double-click on Swap Image to reopen the
Swap Image dialog box.

e Add, delete, or modify source images for rollovers.
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Forms

Forms allow you to collect information from users. Common uses for forms include surveys, order forms, and
search interfaces. Forms require two components: 1) HTML source code describing the form, and 2) a server-
side application (CGl script) to process the information that users enter in the form fields created by the HTML.

Part 1: The HTML source code is the Web interface that contains boxes for users to type in and buttons for
them to click. Dreamweaver can be used to create forms, to add objects to them, and (by using behaviors) to
validate information entered by the user, ensuring that users fill in all required fields. Your Dreamweaver
forms can include standard objects such as text fields, buttons, checkboxes, radio buttons, and list/menus.

Part 2: CGl scripts are small programs, usually written in Perl, that are installed in a special directory on the
server called the CGI-bin. Many servers already have basic scripts installed. Contact your Web server
administrator for more information about the scripts available on your server.

Collaboration with a Perl programmer can produce custom scripts to process your form. Free or inexpensive
scripts can also be downloaded from CGl archives on the Web. Regardless of the source of your script, it
must be installed by the Web server administrator.

If you do not have access to a processing application or script, you can create a simple form that will e-mail the
information to a specified address. That is the approach covered in this handout.

Create a form:

M_. 2 C‘halacters
\Cemm ' o Common
1. Click on the arrow next to Common at the top of the Objects palette. Select Forms from :
the pull-down menu. Form objects are displayed in the Objects palette. i

Inwisibles

Insert Form Insert Text Field

Insert Button Insert Checkbox

Insert Radio Button Insert List/Menu

2. Click on the Insert Form icon.

Red dashed lines appear in the document window. The top line indicates where the form begins in the page,
and the second line marks the end of the form. All of the form elements will be contained inside this dashed

outline. Form objects will not function properly if not inserted inside the red form outline, and they might not
even show up in the page.

Change the following properties in the Properties inspector:

Form Mame Action
Type name here ] Method [FOST -]

L

| &9

Assign a name to the form. Naming a form makes it possible to control it with a scripting language, such
as JavaScript or VBScript.

e The Action box should contain the URL of the server-side application that processes the form

information, specified as a URL. Simple forms can be e-mailed directly to you if you enter mailto:
followed by your e-mail address in the Action box.
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Method determines how the form data is handled. GET should only be used with short forms, while long
forms must be handled with the POST command. Set the Method to POST.

In order for the form data to display correctly when e-mailed, you must add a line to the HTML code.
Click the Show HTML Source icon in the Status bar to open the HTML Source window.

Locate the line of code that contains the Action and Method information and the e-mail address you
entered in the Properties inspector. Type the following at the end of the line INSIDE the angle brackets:

enctype="text/plain”
Your modified code should look like this:

<form method="post"™ action="mailto:athwaitsfu.arizona.edu™ enctype="text/plain™:>

Close the HTML Source window.

Insert a Text Field. Text fields accept any type of text, alphabetic or numeric. The entered text can be

displayed as a single line, as multiple lines, or as bullets or asterisks (for password protection).

Click on the Insert Text Field icon. |[]

A text field appears in the document window and the Properties inspector displays the appropriate
options.

TeutField Char width Type ¥ Singleline  § Multiline  § Paszword ©)
Type name here ] B 4
textfield Max Chars Init al |

Wrap ! - l

Name the text field. Each text field in the form must have a unique name. The name will become a data
label when the input information is processed, and should correspond with the type of information that will
be entered in the field.

Set the number of characters that can be displayed in the field by typing a number in the Char Width box.

Enter a value in the Max Chars box. This is the number of characters that can be entered in the text box.
This number can be greater than the Char Width of the box.

Select a radio button to determine text field Type: single line, multi-line (you set the number of lines), or
password (all characters entered appear as bullets or asterisks).

If you want default text to appear in the field when the page loads, type that text in the Init Val box.

Place the cursor to the left of the text field and type an identifying label for that field (users need to know
what to enter in the field!).

Insert radio buttons. Radio buttons are circles that are clicked to select an item. You can insert as many

radio buttons as you want in a group, but only one can be turned on at a time. When a second radio button is
selected, the first is deselected.

Click the Insert Radio Button icon in the Objects palette. @

A small circle appears in the document window and the Properties inspector displays new options.
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RadioButton Checked Walue radiobuttan Initial State § Checked
|radiobutton lCH Unchecked

e Type a text label next to the radio button.

460

e Name the radio button. All radio buttons in a group must have the same name.

o Enter a Checked Value to set the value of the radio button when it is turned on. This is the value that is
sent to the CGI script for processing. Assign different values to each radio button in a group.

o Initial Value determines if the button is turned on (checked) or off (unchecked) when the page first loads.
Only one button in a group can have an initial state of On.

e Insert several more radio buttons to create a group. Make sure all have the same name but different
checked values.

5. Insert a checkbox. Checkboxes are also inserted in groups, and more than one can be selected at a time, so
they for allow multiple responses in a single group of options.

e Click on the Insert Checkbox icon in the Objects palette. =]

CheckBox Checked Yalue | checkboy Initial State Checked
checkbos o Unchecked

¢ Name the checkbox. All checkboxes in a group must have the same name.

4 FQ

o Enter a Checked Value for the checkbox. This is the value that is sent to the server-side application (for
example, a CGl script) when the user submits the form.

e Select an Initial State to determine whether the checkbox is selected or unselected when the form first
loads.

Insert more checkboxes to create a group.

6. Insert a List/Menu. List/menus Present a set of values from which users can choose. The object can present
a pop-up menu, which appears only when the user clicks the object's name (and which accepts only a single
choice), or a list box, which always displays the values in a scrolling list (and which accepts more than one
choice).

e Click on the Insert List/menu icon in the Objects palette. |E]]

(=)} ListMenu Tupe = Menu Height %

selact r" List Selections l_ Allaw multiple

Initially Selected |

e Assign a unique Name to the list or menu.

e Select Type: a pop-up menu or a scrolling list. For a list, you can set the height (the number of items
displayed at once) and indicate whether the user can select multiple items from the list.
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1. Click the List Values button to open the Initial List Values dialog box so you can add items to the list or pop-
up menu. Each item in the list has a label (the text that appears in the list) and a value (what is sent to the
processing application if the item is selected).

STER— Rearrange order of lst tems
B 162 B o |
[ tem Label [ Value | |
Type item label here | Click here to enter value
Help |

e Click the plus (+) sign to add an item to the list. Click the minus (-) sign to remove an item.

e Listitems appear in the same order as in the Initial List Values dialog box. Use the up and down arrow
buttons to rearrange the order of items in the list.

2. Add a Submit button to your form.

e Click on the Insert Button icon in the Objects palette. |[]

Button Mame Label | Submit Action (¥ Submit form { Dlone
Submit {~ Beset form

No need to name your button — it will automatically be named Submit or Reset, depending on its function.

%6.0

Label determines the text that appears on the button. Accept the default or type your own.

Action determines what happens when the button is clicked. Choose Submit form or Reset form.

3. Preview your form in a browser to test functionality.

Jump Menus

Although jump menus are classified as Form objects, they are not used to collect data from users. They are
navigational devices that contain a pull-down menu of options, each of which will take the user to another page or
Web site.

1. Click on the Insert Form icon.

The jump menu must be inserted between the two red dashed lines in order for it to work correctly. It is not
necessary, however, to specify an Action or a Method for the form in the Properties inspector.

2. Place the cursor between the two red lines. Click on the Insert Jump Menu icon [éj:
in the Form Objects palette. The Insert Jump Menu dialog box opens.
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Insert Jump Menu

Click “+” to add new e |
{‘nedm: |:em, click ™= = == Click arrows to
o delete _
benu ltems: [ oo com [hitp. /v, amazon, com) move _SeleCted
B arnes & Moble [hitp:/ A, b, com menu item up and
down in list, thus
Type text to appear in rearranging order
pull-down menu
Test: [Borders
When Selected, Go To URL:  |hittp: /v borders. com Browwse... |
Type the URL that !
corresponds with the
text in the box above Open URLz In: IMain findow j
b e M arne: |bookstores
Type one-word Select box to add
name for jump menu Options: ¥ Insert Go Button After Menu “Go” button after
I Select First Iem After URL Change lump menu

Fill in the necessary fields in the dialog box, then click OK to create the jump menu.

3. A jump menu (with or without Go button) appears in the document window.
The menu is exactly as wide as it needs to be to accommodate the widest item
in the list, and the width can not be changed manually.

4. With the jump menu selected, look at the Properties inspector. The properties displayed are identical to those
for a regular scrolling list or pull-down menu. The name you chose appears in the name box.

’*‘ S e Height %

bockstores |  List Selections [ Allaw multiple |
Initially Selected ]
Barnes & Maoble |
Borders
itk 1 i AT [F

5. To edit or add to the jump menu, select the jump menu and click on the List Values button in the Properties
inspector. The List Values dialog box appears.

List Walues
——
Add or delete list [3 BB | ok ] Move list items up or
values |tern Label | Yalue | Cancel | down to rearrange
Amazon. com hittp: s fvaaw. arnazan, com order
Barnes & Moble hittp:# A, b, cann
Text that the user sees [——— | Borders hittp: /Ay, borders, com
in the pull-down menu [ | X\(/)?g:sgrzzsssvm?titem
label in left column
Type a new list il

value here

6. To delete the GO button: click on it to select it, then press the Delete key on the keyboard.

To add a GO button . . . well, that’s a little bit trickier. Readon . . .
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Adding a GO button to a Jump Menu

If you forget to add a GO button to your jump menu while the Insert Jump Menu dialog box is open (as outlined on
the previous page), the button must be added manually using the following steps:

1. Place the cursor in the page to the right of the jump menu
2. Click the Insert Button icon in the Form Objects palette. @
A Submit button, the default button type, appears in the page. By changing the properties, this button can be
modified to create a GO button.
3. In the Properties inspector:
J Button Mame | Label [Ga Action £ Submit Form i MNone @
Go | i~ Beset Form =
e Change the button name to “Go.”
e Change the button label to “Go.”
e Choose “None” as the action.
You have changed the physical appearance of the button. To change the button’s function, you must add a
JavaScript behavior.
4. Click on the Behaviors icon in the lower right corner of the Dreamweaver window, or By
select Window>Behaviors from the menu. The Behaviors inspector opens.
5. Click on the Add Actions (+) button to see all available behaviors, and S —
Choose Jump Menu Go from the ||St [}'Historg|ﬂFrames|E§lLagers|‘..".3Eiehau|0rs| @ﬂ
E]B (ST 4 0 and Later Browse
: Call JavaScript :r
Change Proper
6. A dialog box appears prompting you to choose the jump menu that ChecEErowZerty
should be associated with the GO button. If there is more than one Check Plugin
menu in the page, choose the correct menu from the list. Click OK. gf:g“i'ai’;“wa"e S
Go To URL
Jump Menu Go * Jump e
Choosze Jump Menu: Ibookstoles j Open Browser Window
Goes to an URL based on a menu's selected Index. Cancel | =" Flav'Sound
Help |
Behaviars - <buttonz Actions
= Histary | E Frames | E,:_I Layers | 3 Behaviors | @ ﬂ
@B Events For:IS.U and Later Erowser: 'l BB
7. The Behaviors inspector displays the newly added behavior. The = e |
onClick behavior will trigger the JumpMenuGo action when the user
clicks the GO button next to the jump menu.
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